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ENTER MY MONTHLY PARTICIPANT PRIZE DRAWING 
 

I give away a technology product every month,  
and a new Windows 7 computer system at year-end 

 

YOU COULD BE THE NEXT WINNER! 
 

Prize Code for this Course: TNACON 
 
Here at ASA Research, we’ve given away thousands of door prizes to participants attending our 
CPE courses, consisting of thousands of copies of Microsoft Office and Peachtree Software, 
more than seventy-five 21-speed bicycles, hundreds of optical mice, headsets, web cameras, 
keyboards, computer speakers, copies of virus protection software, and yes, numerous ceramic 
chickens and other silly stuff. Thousands of attendees have won door prizes and in 2011, we are 
stepping up the giveaway with a new online giveaway program, which provides you with the 
opportunity to keep winning long after the course is over. This is our way of saying thank you to 
our wonderful, loyal attendees. 
  
 

To enter, visit www.CarltonCollins.com and click on Prize Drawings as shown below: 
 

 
  

http://www.carltoncollins.com/
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Example Prizes 

   
Official Rules & Fine Print 

 
1. Entries are cumulative and do not expire. Each time you enter, your name remains entered. For example, 

a person who obtains 3 prize codes and enters three times, will have three chances to win each month, 
every month thereafter. 

2. You may enter once for each prize code you receive. multiple times using the unique prize codes printed 
in each of Mr. Collins' CPE courses you attend, and provided for each online CPE course you take. 

3. You must enter a prize code to enter. Prize codes can be obtained by attending a CPE course taught by 
Mr. Collins, or by taking Mr. Collins' online CPE courses. Bonus prize codes are also awarded occasionally 
throughout the year to those CPAs who are friends of CPE for CPAs Facebook page and CPAs who follow 
us on Twitter.  

4. A prize will be awarded each month to at least one person, selected at random from among the 
cumulative entries. An e-mail will be sent to the winner(s) requesting a mailing address for prize delivery.   

5. Prizes will continue to be awarded each month until this prize giveaway is terminated. Monthly prizes 
generally consist of less expensive technology items such as headsets, optical mice, GPS devices, 
camcorders, cordless keyboards, digital cameras, USB thumb drives, SD flash cards, computer monitors, 
wireless routers, etc. and will also include an annual grand prize of a new Windows 7 computer system. 

6. ASA Research reserves the right to change these rules at any time, without notice. ASA Research reserves 
the right to terminate this prize giveaway at any time, without notice.  

  



www.CarltonCollins.com  

Copyright August 2011 – J. Carlton Collins, CPA  Page 4 

What’s New in Excel 2010 (At A Glance) 

(ie: Features Not found in Excel 2007) 
 

1. Office Button is replaced with File tab 
2. Backstage View 
3. Double clicking fill handle uses connected columns for fill down 
4. Custom Lists obey character case example 
5. Remove Hyperlinks (instead of one hyperlink at a time in 2007 and 2003) 
6. Sparklines 
7. Conditional Format Improvements 

a. Solid bars 
b. Negative Numbers 
c. More Data Bar Options 
d. More Icon Options 
e. Arrow Colors 
f. Referring to Data 

8. Microsoft Excel Web App’s Improved Sharing 
a. SkyDrive 

i. View 
ii. Sort and Filter 

iii. Browser-Based Editing 
iv. Sharing 
v. Looks the Same 

vi. Same Excel Tools  
vii. Simultaneous Access 

9. Customize the Ribbon 
10. Better compatibility between .xlsx format and Excel 2003 
11. Protected Mode  
12. Trusted Documents 
13. Slicer (Slick new PivotTable filtering) 
14. Macros now record objects (Creation, resizing & moving) 
15. Enhanced Charting 

a. Double Click chart elements to access formatting options 
16. 64-bit version 
17. Microsoft SQL Server PowerPivot for Excel 

a. Query many millions of rows 
b. Fast sorting and filtering 

18. PivotTable - What-If with Write-Back 
19. Recover Earlier Versions Of A File In Office 2010  
20. Named Sets  
21. Excel Mobile 2010 for Windows Phone 7  
22. Improved PivotTables 

a. Performance 
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b. PivotTable Labels 

c. Enhanced Filtering search tool 

d. Write-back support 

e. Show Values As feature 

f. PivotChart Improvements 

23. Improved Solver Add-In  
24. Improved Function Accuracy  

a. Accuracy 
b. Consistency 

25. Improved Filter Capabilities  
a. New Search Filter 
b. Filter and Sort Regardless of Location 
c.  

26. Performance Enhancements  
a. More responsive 
b. Larger Data Sets 
c. Multithreading Improvements 
d. Faster Calculations 

27. Improved Charting  
a. New Limits 
b. Double clickable 
c. Macro Recording of Chart Activities 

28. Support for Equations  
29. More Themes  
30. Paste With Live Preview  
31. Improved Picture-Editing Tools  

a. Screenshot Tool 
b. New SmartArt Graphic Layouts 
c. Picture Corrections 
d. New and Improved Artistic Effects 
e. Better Compression And Cropping 

32. Accessibility Checker Improvements for the Disabled 
33. Improved Language Tools  
34. Improved Programmability Features  

a. SDK 
b. VBA Improvements 
c. Extensibility 
d. Open XML 
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What’s New in Excel 2010 (Explained) 

 
1. Office Button Is Replaced With File Tab – Excel 2007 included the Office Start button, 

which was not intuitive to anybody, despite what Microsoft said.  In Excel 2010, 
Microsoft Office axed the office Start button in favor of the File tab. YIPPY! 

 
2. Backstage View – The file tab provides new look and feel called “Backstage View”. This 

new view represents one of the biggest differences you’ll notice in Microsoft Excel 2010. 
Backstage View is displayed by clicking on Excel’s File tab, as in all the other applications 
that comprise Office 2010. The backstage view in is available in the other Office 2010 
applications, and each application uses a different color scheme to differentiate it from 
the others. In Excel 2010, the color scheme is green. 
  
In general, Backstage View provides basically the same commands found under the File 
menu in previous version of Excel such as Save, Save As, Open, Close, Print, etc. What’s 
new is the preview screen and info tabs that accompanying some of these selections. 
For example, when you select the print option, a preview of the print job is 
automatically displayed, as shown below. 
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The Print option Backstage View also provides access to various Page and Print settings, 
such as Duplexing, Orientation, Margins, and Scaling. The save and Send option also has 
a new look and feel, providing buttons for emailing, publishing, and saving files, as well 
as options to create PDF or XPS documents.  
 

 
The New option also incorporates a new look and feel with thumbnail previews of 
templates, and links to downloading more templates from the Web. 
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If you want to return to the old Excel 2007 look and feel when you click the File tab (not 
that you would want to), you can change registry settings, as detailed in this article on 
Turning Off The Microsoft Office 2010 OutSpace located here: 
 

http://www.off14.com/microsoft-office-2010-outspace/ 
 
(They’ve actually got the name wrong in this article; although the registry key is named 
“outspace”, the display is called Backstage View.)  
 

3. Double Clicking Fill Handle Uses Connected Columns For Fill Down – In previous versions of 
Excel, the double click only worked if data were located in the column immediately to the 
left or right of the range to be copied, but Excel 2010 will use more distant columns 
provided they are connected with a common set of column labels.  
 

4. Custom Lists Obey Character Case Example – When using the Smart List feature, Excel 2010 
obeys the case (proper, lower, and upper) that is used in your starting phrase.  

 
5. Remove Hyperlinks (Instead Of One Hyperlink at A Time In 2007 And 2003) – In earlier 

versions of Excel, you could only remove one hyperlink at a time (the work around is to copy 
and paste a range containing hyperlinks and paste them as text elsewhere, then copy and 
paste that result back to your original location. Excel 2010 can remove all hyperlinks from a 
range in just one step. 

 
6. Sparklines – Sparklines are small cell-sized charts that you can embed in a worksheet next 

to data to get a quick visual representation of the data. For example, if you had a worksheet 
that tracked the performance of several dozen stocks, you could create a Sparkline for each 
stock that graphed its performance over time, in a very compact way. Here are examples: 

 

http://www.off14.com/microsoft-office-2010-outspace/
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7. Conditional Formatting Improvements – Microsoft has improved and added more styles 

and icons regarding the ability to apply a format to a range of cells, and then have the 
formatting change according to the value of the cell or formula.  

 
a. Solid Bars - Data Bars can be solid now in Excel 2010. Excel 2007 bars offered only a 

gradient effect, which was visually was confusing to read. Below is a comparison on the 
Excel 2007 and Excel 2010 Data Bar options.  

 

  
 

b. Negative Numbers - Microsoft also corrected a problem which Excel 2007 had creating 
when Data Bars based on negative numbers by adding axis support for both positive and 
negative values. The screens shots below show Excel 2010’s new solution, and how 
Excel 2007 got confused when applying Data Bars to the exact same data. 

 

  
 

c. More Data Bar Options - Notice that Microsoft added more Data Bar options as shown in the 
comparison below. 

   2007 Gradient           2010 Gradient       2010 Solid 

              Excel 2010’s Data Bars               Excel 2007’s Data Bars 
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d. More Icon Options - Notice that Microsoft added more Data Bar options as shown in the 
comparison below. 

           Excel 2010’s Data Bar Menu            Excel 2007’s Data Bar Menu 
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e. Arrow Colors - It is possible to change icons used for KIP i.e. You can have two arrows with 
different colors of if negative impact and positive growth are good for you. 

 
f. Referring to Data - You can now refer to data on different worksheets, and even refer to a range 

outside the Conditional Formatting area. The screen below shows the error message produced 
by Excel 2007 when you attempted to reference cells outside the Conditional Formatting area; 
Excel 2010 now accommodates this situation. 

              Excel 2010’s Icon Menu         Excel 2007’s Icon Menu 
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8. Microsoft Excel Web App’s Improved Sharing – Excel 2010 has new and improved tools for 
sharing data with other people, including multiple people working on the same document at 
the same time. Excel Web App extends your Excel experience to the web browser, where 
you can work with workbooks directly on the site where the workbook is stored. Excel Web 
App is part of Microsoft Office Web Apps, and is available in Windows Live SkyDrive and in 
organizations that have configured Office Web Apps on SharePoint 2010. With Excel Web 
App, you can: 

a. View - View a workbook in the browser - When you click on a workbook to open 
it in Excel Web App, the workbook is displayed in view mode.  

b. Sort and Filter - You can sort and filter data in the workbook, expand PivotTables 
to see relationships and trends in the data, recalculate values, and view different 
worksheets. 

c. Browser-Based Editing - Edit a workbook in the browser - With Excel Web App, 
all you need to access your workbooks is a browser.  

d. Share - Your teammates can work with you, regardless of which version of Excel 
they have.  

e. Looks the Same - Your workbooks look the same in the browser as they do in 
Excel.  

f. Excel Tools - You can edit your worksheets in the browser, using the familiar look 
and feel of Excel. When you edit in the browser, you can change data, enter or 
edit formulas, and apply basic formatting within the spreadsheet.  

g. Simultaneous Access - You can also work with others on the same workbook at 
the same time. 

 
Microsoft offers a free solution called Windows Live SkyDrive, which enables everyone in 
your group to share Word and Excel (and other) documents. This solution also provides 
users with Word, Excel and PowerPoint applications (with limited functionality) so your 
group members can work in the same applications.  

Excel 2007 
Error 

Message 
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To use SkyDrive, sign up for a free Windows Live account at http://explore.live.com/. 
Under the SkyDrive menu, select Get started and follow the instructions for setting up a 
Windows Live account. Once you have completed the registration process, sign into your 
Windows Live Sky Drive account and click the Office menu option at the top of the screen to 
view your SkyDrive as follows: 
 

 
 
Next create a folder and upload (or create) the group’s Word and Excel files. Select the 
folder and click the Share menu option as shown to edit permissions and to send links to 
your group members, which will enable them to access the data files.  

 
When sharing files in this manner, to better protect your data, check the checkbox labeled 
Require recipients to sign in with Windows Live ID. This action will require your group 
members to obtain their own Windows Live accounts and use their passwords in order to 
access the data files. Otherwise, anyone who receives the link will be able to access the data 
files.  
 
Notes: The free version of Windows Live Sky Drive is limited to 25 GBs of storage, and 
individual files are limited to 50 MBs. For a fee, you can increase these capacities. Installing 
Microsoft’s free Silverlight browser add-in will enable drag and drop functionality to and 

http://explore.live.com/windows-live-skydrive?wa=wsignin1.0
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from your SkyDrive. The Windows Live SkyDrive solution was first introduced in August 
2007, and is widely used.  

 
9. Customize the Ribbon Toolbar - The Ribbon tool bar has been enhanced, and is now highly 

customizable. For example, you can add your own tabs to the Ribbon (as shown below), you 
can add your own groups to each tab (also shown below), and you can add any commands 
or macros to your customized tabs and groups.  

 
 

10. Compatibility of .xlsx - In Excel 2007, Microsoft introduced a new XML format (.xlsx) which was not 
compatible with former .xls spreadsheet formats. This problem has been resolved - Excel files 
created in Excel 2010 may easily be opened in versions of Excel prior to Excel 2007. Now Excel 2010 
will save files just as safe as the former Excel 2007, and the spreadsheet size is 75% smaller than the 
old .XLS version. 

 

 
 
11. Protected Mode - Excel 2010 includes a Protected View, so you can see the document and make 

a more informed decision before exposing your computer to possible vulnerabilities. By default, 
documents that originate from an Internet source are opened in Protected View. When this 
happens, you see a warning on the Message bar, along with the option to enable editing. You can 
control which originating sources trigger Protected View. You can also set specific file types to open 
in Protected View regardless of where they originate. Excel will not allow you to edit the documents 
unless document editing is enabled. To do this, click the Enable Editing option in order to enable 
document editing as shown in the following screen shot. 

 

 
 

http://www.addictivetips.com/wp-content/uploads/2009/09/protectedmode11.png
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12. Trusted Documents - The trusted documents feature is designed to make it easier to open 

workbooks and other documents that contain active content, such as data connections or 
macros. Now, after you confirm that active content in a workbook is safe to enable, you don’t 
have to repeat yourself. Excel 2010 remembers the workbooks you trust so that you can avoid 
being prompted each time you open the workbook. 
 

13. Slicer - The Slicer feature provides new slice and dice capabilities within PivotTables – this 
helps you dynamically segment and filter the data. This feature is located on the Insert Tab. 

 

 
 

14. Macro - Macros in Excel 2010 now support working with shapes, including creating, moving or 
editing shapes. For example, you could now record a macro that automatically insert s the 
following SmartArt object. 

 
15. Enhanced Chart Diagram - In Excel 2010 double clicking a chart element automatically 

opens the chart’s format dialog box. 
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16. 64-bit version of Excel 2010 - Excel 2010 is now available in a 64-bit version, which 
means that it can take full advantage of your computer’s 64-bit motherboard and access 
more than 4 GBs of RAM. The result is even faster performance. 
 

17. Microsoft SQL Server PowerPivot for Excel - Excel 2010 now includes an add-in tool called 
Microsoft SQL Server PowerPivot which is a Business Intelligence tool that enables you to query 
multiple SQL Server databases across multiple corporate systems and web data on a real-time 
basis to produce PivotTables that can be shared via SharePoint. You can try this online at the 
following Virtual Labs web site:  
 

https://cmg.vlabcenter.com/prepare.aspx?moduleid=ad3bd3e9-8d2b-498d-94fa-
e41e1b09730d&ticks=633992819904236083. 

 

Microsoft now offers Project Gemini add-on for Excel 2010 that can handle very large 
amounts of data -- even worksheets that include hundreds of millions of rows. It will 
ship as part of SQL Server 2008 R2 in the first half of 2010; a community technology 
preview will be available in the second half of 2009. 

 

18. What-If with Write-Back - PivotTable What-If Analysis is the ability to modify values in 
PivotTable cells, recalculate the PivotTable with those values and, if the results are 
satisfactory, publish the changes so that they are reflected in the OLAP data source for 
other people to see. This feature is also called write back, though it really goes beyond 
just the ability to write values back to the cube. “What if our sales for New York 
increased by 10%?” “What if the total number of product orders fell by 25%?” These are 
examples of questions that PivotTable What-If Analysis is aimed at helping the user 
answer. Let’s take a look at the following scenario: 

 
Stephen, the sales manager at a small IT company, is trying to figure out what his 
optimal sales quotas should look like for 2010. Based on a previous analysis and 
forecasts for next year it seems like 2010 will have a large decrease in sales which would 
mean his quotas would be reduced by 10% from the 2009 quotas. With the new 
PivotTable What-If Analysis feature he can now modify the relevant values in his 
PivotTable report and calculate the PivotTable with the changes to see what the totals 
would look like without actually modifying the data source. (click to see larger image) 

https://cmg.vlabcenter.com/prepare.aspx?moduleid=ad3bd3e9-8d2b-498d-94fa-e41e1b09730d&ticks=633992819904236083
https://cmg.vlabcenter.com/prepare.aspx?moduleid=ad3bd3e9-8d2b-498d-94fa-e41e1b09730d&ticks=633992819904236083
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So here is what his PivotTable looks like after calculating with the changes: 

 
If he wants to keep these numbers and share them with other people he can go ahead 
and publish the changes to the OLAP data source. 

 
He can also just keep the changes locally without publishing back to the OLAP data 
source by simply saving the file. When the workbook is loaded again in Excel 2010 all the 
changes will be reapplied and the PivotTable recalculated. With little knowledge of 
OLAP data sources the manager was able to change values and recalculate his 
PivotTables. The changes can be shared across the organization by simply sharing the 
workbook or publishing the changes back to the OLAP data source. 

http://blogs.msdn.com/blogfiles/excel/WindowsLiveWriter/e5d0dd774f30_BC40/image_14.png
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Advanced Options - Advanced options for PivotTable What-If Analysis include being 
able to change the allocation method, which is the methodology in which the OLAP data 
source will allocate the newly entered values in the cube. Excel 2010 also gives you the 
ability to define your own weight allocation definitions from within an MDX editor.  
 

19. Recover Earlier Versions Of A File In Office 2010 - It is now easier to recover a Microsoft 
Word 2010, Microsoft Excel 2010, or Microsoft PowerPoint 2010 file if you close your 
file without saving, or you want to review or return to an earlier version of the file 
you're already working in.  
 
As with earlier versions of Office, enabling AutoRecover in Word 2010, Excel 2010 or 
PowerPoint 2010 will save versions while you are working in your file at the interval you 
select. Now, you can choose to keep the last autosaved version of a file in case you 
accidentally close that file without saving, so that you can restore it the next time that 
you open the file. Also, while you are working in your file, you can access a listing of the 
autosaved files from the Microsoft Office Backstage view. 
  
Note: You must have the “Save AutoRecover information” and “Keep the last autosaved 
version if I close without saving” enabled for these features to work. (The Recover 
Unsaved Workbooks option is available from the File tab, under the Recent menu 
option.  

 
20. Named Sets - Named Sets have been added to Microsoft Excel 2010, allows you to create your 

own named sets. Simply locate the Fields, Items, & Sets button under the Ribbon, and it will 
allow you to define your own Named Sets. 
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21. Excel Mobile 2010 for Windows Phone 7 - If you have Windows Phone 7, you can use 

Microsoft Office Mobile 2010 to work with your files from anywhere—whether you’re at 
work, at home, or on the go. Excel Mobile 2010 is part of Office Mobile and already on 
your phone in the Office Hub, so you don't need to download or install anything else to 
get started. 

 

You can use Excel Mobile to view and edit workbooks stored on your phone, sent to you 
as email attachments, or hosted on a SharePoint 2010 site through SharePoint 
Workspace Mobile 2010. When you edit a workbook via SharePoint Workspace Mobile, 
you can save your changes back to the SharePoint site when you’re online. You can 
create, update, and instantly recalculate your spreadsheets using many of the same 
tools you already know and use in the desktop version of Excel: 

a) Use the outline view to switch between worksheets or charts in a workbook. 
b) Sort, filter, and manage your spreadsheets.  
c) Add or edit text and numbers. 
d) Add comments. 

22. Improved PivotTables 

PivotTables are now easier to use and more responsive. Key improvements include: 
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a) Performance - In Excel 2010, multi-threading helps speed up data retrieval, sorting, 
and filtering in PivotTables. 

b) PivotTable Labels - It's now possible to fill down labels in a PivotTable. You can also 
repeat labels in PivotTables to display item captions of nested fields in all rows and 
columns. Watch a video about repeating item labels. 

c) Enhanced Filtering - You can use slicers to quickly filter data in a PivotTable with the 
click of a button and see which filters are applied without having to open additional 
menus. In addition, the filter interface includes a handy search box that can help you 
to find what you need among potentially thousands (or even millions) of items in 
your PivotTables. 

d) Write-back Support - In Excel 2010, you can change values in the OLAP PivotTable 
Values area and have them written back to the Analysis Services cube on the OLAP 
server. You can use the write-back feature in what-if mode and then roll back the 
changes when you no longer need them, or you can save the changes. You can use 
the write-back feature with any OLAP provider that supports the UPDATE CUBE 
statement. 

e) Show Values As feature - The Show Values As feature includes a number of new, 
automatic calculations, such as % of Parent Row Total, % of Parent Column Total, % 
of Parent Total, % Running Total, Rank Smallest to Largest, and Rank Largest to 
Smallest. Watch a video about changes to the Show Values As feature. Watch a 
video about changes to the Show Values As feature. 

f) PivotChart Improvements - It is now easier to interact with PivotChart reports. 
Specifically, it's easier to filter data directly in a PivotChart and to reorganize the 
layout of a PivotChart by adding and removing fields. Similarly, with a single click, 
you can hide all field buttons on the PivotChart report.  

 
23. Improved Solver Add-In - Excel 2010 includes a new version of the Solver add-in, which 

you can use to find optimal solutions in what-if analysis. Solver has an improved user 
interface, a new Evolutionary Solver, based on genetic algorithms, that handles models 
with any Excel functions, new global optimization options, better linear programming 
and nonlinear optimization methods, and new Linearity and Feasibility reports. In 
addition, the Solver add-in is now available in a 64-bit version. 
 

Use Solver to determine the maximum or minimum value of one cell by changing other 
cells. For example, you can change the amount of your projected advertising budget 
and see the effect on your projected profit amount. 

 

Example of a Solver problem - In the following example, the level of advertising in 
each quarter affects the number of units sold, indirectly determining the amount of 
sales revenue, the associated expenses, and the profit. Solver can change the quarterly 

http://office.microsoft.com/en-us/excel-help/redir/VA101812170.aspx?CTT=5&origin=HA010369709
http://office.microsoft.com/en-us/excel-help/redir/VA101812176.aspx?CTT=5&origin=HA010369709
http://office.microsoft.com/en-us/excel-help/redir/VA101812176.aspx?CTT=5&origin=HA010369709
http://office.microsoft.com/en-us/excel-help/redir/VA101812176.aspx?CTT=5&origin=HA010369709
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budgets for advertising (cells B11:E11), up to a total budget constraint of $40,000 (cell 
F11), until the value for the total profit reaches the maximum possible amount. The 
values in the decision variable cells are used to calculate the profit for each quarter, so 
the values are related to the formula in the target cell F15, =SUM(B15:E15). 

 

 

Decision variable cells 

Constraint cell 

Objective cell 

 

After Solver runs, the new values are as follows. 

 

 
For more solver examples, check out:  
http://www.solver.com/excel2010/solverhelp.htm  
 

24. Improved Function Accuracy - Excel 2010 includes more accurate statistical and other 
functions. Certain existing functions have also been renamed to better describe what 
they do, as follows:  

a) Accuracy Improvements - A number of functions have been optimized to improve 
accuracy. For example, Excel 2010 returns more accurate results for the beta and 
chi-squared distributions. 

 

http://www.solver.com/excel2010/solverhelp.htm
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b) More Consistent Functions - Certain statistical functions have been renamed so that 
they are more consistent with the function definitions of the scientific community 
and with other function names in Excel. The new function names also more 
accurately describe their functionality. Workbooks created in earlier versions of 
Excel will continue to work despite these name changes, because the original 
functions still exist in a Compatibility category. 

 

25. Improved Filter Capabilities - In addition to slicers, which are described earlier in this 
article, Excel 2010 comes with new features that make it easier to sort and filter data, as 
follows. 

 
a. New search filter - When you filter data in Excel tables, PivotTables, and 

PivotCharts, you can use a new search box, which helps you to find what you 
need in long lists. For example, to find a specific product in a catalog that stocks 
over 100,000 items, start by typing your search term, and relevant items 
instantly appear in the list. You can narrow the results further by deselecting the 
items you don't want to see. 
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b. Filter And Sort Regardless Of Location - In an Excel table, table headers replace 
regular worksheet headers at the top of columns when you scroll down in a long 
table. AutoFilter buttons now remain visible along with table headers in your 
table columns, so you can sort and filter data quickly without having to scroll all 
the way back up to the top of the table.  

 

26. Performance Enhancements - Performance improvements in Excel 2010 can help you to 
interact with your data more efficiently. Specific investments include: 

 
a) General improvements - Excel 2010 is more responsive when you move and resize 

charts, work in Page Layout view, and interact with shapes on the worksheet.  

b) Support For Large Data Sets - Excel 2010 handles workbooks that contain massive 
amounts of data more efficiently. Specifically, it takes less time to perform activities 
commonly performed on large data sets, such as filtering and sorting the data, copy 
and pasting it from one worksheet to another, and using the Fill feature to copy 
formulas.  

c) Multicore Improvements - Multithreading improvements in Excel 2010 help to 
speed up the process of retrieving, sorting, and filtering data in PivotTables and 
Excel tables. In addition, opening and saving large files is generally faster than 
before. 

d) Faster Calculation - To achieve faster calculation performance, Excel 2010 includes 
support for asynchronous user-defined functions, which can run simultaneously 
without using multiple Excel calculation threads.  

27. Improved Charting - It's now easier to work with charts in Excel 2010. Specific 
improvements include: 

 
a) New Charting Limits - In Excel 2010, the limitation on the number of data points that 

can be created on a chart has been removed. The number of data points is now 
limited only by available memory.  
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b) Quick Access To Formatting Options - In Excel 2010, you can instantly access 
formatting options by double-clicking a chart element. 

c) Macro Recording For Chart Elements - In Office Excel 2007, recording a macro while 
formatting a chart or other object did not produce any macro code. In Excel 2010, 
however, you can use the macro recorder to record formatting changes to charts 
and other objects. 

28. Support for Equations - You can use the new equation editing tools in Excel 2010 to 
insert common mathematical equations into your worksheets or to build up your own 
equations by using a library of math symbols. You can also insert new equations inside 
of text boxes and other shapes. To get started, on the Insert tab, in the Symbols group, 
click the arrow next to Equation.  

 

 

29. More Themes - In Excel 2010, there are more themes and styles than ever before. These 
elements can help you apply professional designs consistently across your workbooks 
and other Microsoft Office documents. Once you select a theme, Excel 2010 does the 
design work. Text, charts, graphics, tables, and drawing objects all change to reflect the 
theme you have selected, so that all elements in your workbook visually complement 
one another. 
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30. Paste With Live Preview - The paste with live preview feature enables you to save time 
when reusing content within Excel 2010 or across other programs. You can use it to 
preview various paste options, such as Keep Source Column Widths, No Borders, or 
Keep Source Formatting. The live preview enables you to visually determine how your 
pasted content will look before you actually paste it in the worksheet. When you move 
your pointer over Paste Options to preview results, you'll see a menu containing items 
that change contextually to best fit the content you are reusing. ScreenTips provide 
additional information to help you make the right decision. 

 

31. Improved Picture-Editing Tools - If you use photos, drawings, or SmartArt to 
communicate visually, you can take advantage of the following features:  

 
a) Screenshots - Quickly take a screenshot and add it to your workbook, and then use 

the tools on the Picture Tools tab to edit and improve the screenshot. 

 

b) New SmartArt Graphic Layouts - With new picture layouts, you can tell your story 
with photographs. For example, use the Captioned Picture layout to show pictures 
with nice-looking captions underneath.  



www.CarltonCollins.com  

Copyright August 2011 – J. Carlton Collins, CPA  Page 26 

c) Picture Corrections - Fine tune the color of a picture, or adjust its brightness, 
contrast, or sharpness—all without having to use additional photo-editing software.  

d) New and Improved Artistic Effects - Apply different artistic effects to your picture to 
make it look more like a sketch, drawing, or painting. New artistic effects include 
Pencil Sketch, Line Drawing, Watercolor Sponge, Mosaic Bubbles, Glass, Pastels 
Smooth, Plastic Wrap, Photocopy, Paint Strokes, and many more.  

e) Better Compression And Cropping - You now have better control of the image 
quality and compression tradeoffs, so that you can make the right choice for the 
medium (print, screen, e-mail) that your workbook will be used for. Read more 
about cropping and picture compression. 

32. Accessibility Checker - The new Accessibility Checker tool in Excel 2010 enables you to 
find and fix issues that can make it difficult for people with disabilities to read or interact 
with your workbook. You can open the Accessibility Checker by clicking the File tab, 
clicking Check for Issues, and then clicking Check Accessibility. Errors and warnings will 
appear in a task pane. You can then review the issues and see which ones you need to 
fix. In addition to the Accessibility Checker, you can add alternative text to more objects 
in your worksheet, including Excel tables and PivotTables. This information is useful to 
people with visual impairments who may be unable to easily or fully see the object. 

 
33. Improved Language Tools - In the Excel Options dialog box, multilingual users can 

quickly set preferences for editing, display, ScreenTip, and Help languages. And, 
changing your language settings in Excel automatically changes them across all 
applicable Microsoft Office 2010 applications. If you don't have the software or 
keyboard layout installed that you need, you are notified, and links are provided to 
make it easier to quickly resolve such issues. 
 

34. Improved Programmability Features - Improvements for developers include:  
 

a) Changes to the XLL SDK - The XLL Software Development Kit (SDK) now supports 
calling new worksheet functions, developing asynchronous user-defined functions, 
developing cluster-safe user-defined functions that can be offloaded to a compute 
cluster, and building 64-bit XLL add-ins. 

b) VBA Improvements - Excel 2010 has a number of features that will enable you to 
migrate any remaining Excel 4.0 macros you may have to VBA. Improvements 
include better performance for print-related methods and chart properties not 
previously accessible with VBA. 

c) Better User-Interface Extensibility - If you develop custom workbook solutions, you 
have more options for programmatically customizing both the ribbon and the new 
Backstage view. For example, you can programmatically activate tabs on the ribbon, 
and make custom tabs behave similarly to built-in contextual tabs, where tabs only 
appear when specific events occur. In addition, you can make custom ribbon groups 

http://office.microsoft.com/en-us/excel-help/redir/HA010355164.aspx?CTT=5&origin=HA010369709
http://office.microsoft.com/en-us/excel-help/redir/HA010355164.aspx?CTT=5&origin=HA010369709
http://office.microsoft.com/en-us/excel-help/redir/HA010355184.aspx?CTT=5&origin=HA010369709
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grow and shrink as the ribbon is resized and customize context menus with rich 
controls. You can also add custom UI and other elements to the Backstage view. 

d) Changes to the Open XML SDK - The Open XML SDK 2.0 now supports schema-level 
objects, in addition to the part-level support introduced in the Open XML SDK 1.0. 
This makes it easier to programmatically manipulate workbooks and other 
documents outside the Office 2010 desktop applications—for example, as part of a 
server-based solution. 

 

What’s New in Word 2010? 
 

1. Office Button Is Gone – Microsoft has replaced the Office button in the most recent Word 2010 
beta with the File tab, which I think better fits into the interface. 
 

2. Print Preview Has Moved – Microsoft moved the Print command to the File Tab menu. 
Choosing that command displays a Print window, and the Print Preview is now located on the 
right side of the window. I think it is a good improvement, but a lot of folks will probably wander 
around Word 2010 looking for the Print Preview command. 
 

3. Menu Options Disappear - Many of the lesser-used command buttons are gone or have been 
replaced. It takes a little getting used to. 

 
4. Navigation Pane - Document Map has been renamed Navigation pane – what a pane? 

 
5. New Find Command - Instantly highlights all instances of the text you’re searching for. 

Unfortunately, Ctrl+F now launches the Navigation pane and not the Find Dialog Box. Launching 
the Find dialog box is now a little awkward; you have to go to the Find & Replace dialog box, 
then backtrack to the Find dialog box.  
 

6. Mail Merge  - Microsoft has changed the mail merge feature in that the “address list” is now 
called the “recipient list.” Also, the main document is no longer the “main document,” it now 
has no name.  
 

7. Customize Ribbons - You can now customize the Ribbons in Word. You cannot change Word’s 
tabs and groups, but you can add your own custom group to any of Word’s tabs, or create your 
own tab, and place your favorite commands into those groups.  

 

What’s New in PowerPoint 2010? 
 

1. Office Button Is Gone – Microsoft has replaced the Office button in the most recent Word 2010 
beta with the File tab, which I think better fits into the interface. 

2. Macro Recorder – Microsoft has brought back the macro recorder capability in PowerPoint 
which disappeared in Office 2007. 
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3. Permissions – PowerPoint 2010 allows you to protect the presentation by setting permissions 
on the File tab. 
 

4. Transitions Tab - Slide transitions have always been a part of PowerPoint. However, the 
Transitions tab is new to the PowerPoint 2010 ribbon. 
 

5. Animation Painter - Microsoft has created a tool that works similarly to the Format Painter, 
which has been around as long as I have been using any Office products. The Animation Painter 
will copy all the animation features of an object to; another object, another slide, multiple slides 
or to another presentation. This is a real time-saver as you do not have to add all these 
animation properties separately to each object. The added bonus is many fewer mouse clicks. 
 

6. Broadcast Slide Show Feature - PowerPoint 2010 now offers the ability to share your 
presentation over the internet to anyone in the world. By sending a link to the URL of your 
presentation, your global audience can follow along in their browser of choice. The viewers 
need not have PowerPoint installed on their computer. 
 

7. Minimize the Ribbon - This is a small feature, you can hide the ribbon using a tiny button to do 
it with less clicks of the mouse. 
 

8. Embed a Video or Link to a Video - PowerPoint 2010 now offers the option to embed or link to a 
video (which is currently located on your computer) into your presentation, or to link to a video 
on a website, such as YouTube. Embedding a video which is located on your computer saves a 
lot of anguish if you later move or send your presentation to another location. Embedding the 
video means that it always stays with the presentation, so you don't have to remember to also 
send the video file along. The video can be of an actual "movie" type or you can also embed an 
animated GIF type of clip art. 
 

9. Linking To A Video – Linking rather than embedding greatly reduces the file size of the overall 
presentation. However, you take the risk of forgetting to copy over the video file when you 
move the presentation to another location. When you link to a video on the web, such as 
YouTube, the video is not really in your presentation, so you will always need an internet 
connection in order to view the video. 
 

10. Turn PowerPoint 2010 Presentations into Videos - Microsoft has realized the need to be able to 
convert a presentation into a video, without the use of third party software. Users of 
PowerPoint have been asking for this for years, and at long last the feature is present in 
PowerPoint 2010. Advantages of Converting a PowerPoint 2010 Presentation into Video: 
 

a. The WMV video file format can be read by most computers. 
b. You can still use other software to convert the presentation into other file formats (such 

as AVI or MOV for example) if you choose. 
c. Any transitions, animations, sounds and narration will be embedded into the video. 
d. The video can be published to a website or emailed. It is not editable, so the entire 

presentation will always remain as the author intended. 
e. You can control the file size of the video by selecting appropriate options. 
f. The targeted audience does not need to have PowerPoint installed on their computer in 

order to view the video. 
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What’s New in Outlook 2010? 
 

1. Ribbon - While the ribbon introduced in Office 2007 is still present, in Outlook 2010, it’s evolved 
into a cleaner and easier-to-use interface. 
 

2. New Conversation View - A new view in the inbox pane has been created called the 
conversation view. With it, messages are sorted not just by date, but by conversation. When you 
start a dialog with one or more people, any subsequent replies to that thread are automatically 
added to the conversation view for that topic. 
 

3. MailTips – This is a new feature that provides information to the user before he or she sends a 
message. For example, you may have a MailTip to warn users when they are sending an email to 
outside the organization or sending to a large audience. MailTips are not enforced rules, but 
they do provide some guidance to users before they send a message, and with Exchange 2010 
custom mail tips can be created on the server and seen by clients when they apply. 
 

4. Quick Steps - You can define custom, or frequently used actions, called Quick Steps. For 
example, you could have a quick step to CC your manager, schedule a meeting, or reply and 
then delete the message. 
 

5. Automatically Calendar Retrieval - If you receive a meeting invitation that conflicts with 
another appointment, Outlook automatically brings up your calendar, making it easy to find a 
time that you are available and reschedule. 
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Bio for J. Carlton Collins, CPA 
ASA Research   Carlton@ASAResearch.com   770.842.5902 

 
J. Carlton Collins, CPA is a Certified Public Accountant with experience in technology, tax, 
auditing, accounting systems, financial reporting, and bond financing. He is an author, 
lecturer, and technology & accounting systems consultant. He has published books, 
articles, and web pages and is the author of the monthly technology Q&A column for the 
Journal of Accountancy. As a public speaker, Mr. Collins has delivered more than 2,000 
lectures in 44 states and 5 countries addressing more than 500,000 CPAs and business 

professionals. As a consultant, Mr. Collins has assisted 275+ large and small companies with the selection and 
implementation of accounting systems. Mr. Collins has a Bachelor’s degree in Accounting from the University of Georgia, is 
a 25+ year member of the American Institute of CPAs and the Georgia Society of CPAs, and is also a licensed realtor. 
  
Summary of Selected Positions, Awards & Accomplishments:  
  

1.   Honored as one of the CPA Industries Top 25 Thought Leaders by CPA Technology Advisor Magazine 
2.   Author of the monthly Technology Q&A column for the Journal of Accountancy. 
3.   Recipient of the AICPA’s Lifetime Technical Contribution to the CPA Profession Award.  
4.   Chairman of the Southeast Accounting Show - the South’s largest CPA event. 
5.   Recipient of the Tom Radcliff Outstanding Discussion Leader Award.  
6.   Named “Top Ten CPA Technologists” by Accounting Technologies Magazine (multiple years). 
7.   Named “Top 100 Most Influential CPAs ” by Accounting Technologies Magazine (multiple years). 
8.   Has personally delivered over 2,000 technology lectures around the world. 
9.   Recipient of the Outstanding Discussion Leader Award from the Georgia Society of CPAs.  
10. Lead author for PPC's Guide to Installing Microcomputer Accounting Systems.   
11. Has installed accounting systems for more than 200 companies. 
12. Chairperson of the AICPA Technology Conference.  
13. Recipient of the ACCPAC Partner of the Year Award. 
14. Determined by SAP to be one of the country's "Top Ten Most Influential ERP Systems Consultants". 
15. Has delivered keynote and session lectures at dozens of accounting software conferences. 
16. Sworn in as a Certified Public Accountant on September 18, 1985. 
17. Member of the American Institute of CPAs since 1985. 
18. Member of the Georgia Society of CPAs since 1982. 

  
 As an auditor, Mr. Collins has audited businesses in the areas of health care, construction, distribution, automobile 
dealerships, insurance, manufacturing, and general business.  Mr. Collins' tax experience includes corporate, individual, 
partnership, fiduciary, and estate tax planning work.  In the area of finance, Mr. Collins has prepared (or assisted in 
preparing) feasibility studies and financial forecasts for nearly 300 projects seeking more than $3 billion in startup capital. 
Mr. Collins is familiar with bond issues, Medicare and Medicaid reimbursement, and conventional financing matters. In 
1992, Mr. Collins contributed and demonstrated more than 500 pages of suggested design improvements to the Microsoft 
Excel development team of programmers - and many of those improvements are found in Excel today. 
 
At the University of Georgia, Mr. Collins was elected President of the Phi Eta Sigma Honor Society, was initiated into the 
BIFTAD Honor Society, served three years in the Judicial Defender/Advocate program, and was a member of Alpha Tau 
Omega fraternity. At Glynn Academy High School, Mr. Collins was Senior Class President, Class Valedictorian (1 of 6), and 
received a principle nomination to Annapolis Naval Academy. Mr. Collins has been married for 27 years and has two 
children. He devotes his leisure time to family, travel, tennis, fishing, snow skiing, and riding motorcycles (both dirt and 
street). Mr. Collins is president of his homeowners association, participates in the Gwinnett Clean and Beautiful program, 
and volunteers for Cooperative Ministries food drive. 
  

mailto:Carlton@ASAResearch.com
http://www.journalofaccountancy.com/
http://www.cpatechnologyadvisor.com/web/online/NEWS/The-CPA-Technology-Advisors-Top-25-Thought-Leader-Symposium-Honors-Achievement/1$3210


www.CarltonCollins.com  

Copyright August 2011 – J. Carlton Collins, CPA  Page 31 

A few quotes to brighten your day. Enjoy! 
 

 I’m so poor I can’t even pay attention 

 I have enough money to last me the rest of my life...unless I buy something. 

 It's so simple to be wise. Just think of something stupid to say and then don't say it! 

 I'm searching for fun and happiness that does not involve food or money... 

 We make a living by what we get, we make a life by what we give. 

 Count your age with friends but not with years. 

 Never play leapfrog with a unicorn. 

 Friction can be a drag. 

 When I want your opinion, I'll remove the duct tape. 

 Light travels faster than sound. That's why some people appear bright until you hear them speak. 

 Football is a combination of two of America’s worst elements: Violence and committee meetings. 

 I haven't spoken to my wife in years; I don't like to interrupt her. 

 My fake plants died because I did not pretend to water them 

 Never let a computer know you're in a hurry. 

 I totally take back all those times I didn't want to nap when I was younger. 

 I planned to surprise my wife with a new centerpiece for the table...but the taxidermist was closed. 

 I have kleptomania, but when it gets bad, I take something for it. 

 For every action, there is an equal and opposite government program.  

 Even free advice costs more than it used to. 

 Love is holding hands in the street. Marriage is holding arguments in the street. 

 I always try to hold hands with my wife...because if I let go she'll start shopping! 

 My back goes out more than I do. 

 An Adult is a person who has stopped growing at both ends and is now growing in the middle. 

 The journey of a thousand miles ... begins with a broken fan belt. 

 I'm getting serious about exercising - I've moved my TV set much farther away from my refrigerator. 

 A Freudian slip is when you say one thing but mean your mother. 

 While in the army, Will never liked the phrase "Fire at will". 

 Studies have shown that you can live longer by having more birthdays. 

 My wife keeps saying that I don’t listen to her...or something like that. 

 My life goal is to be filthy stinking rich...well, 2 out of 3 ain't bad. 

 A child of five would understand this. Send someone to fetch a child of five. 

 Warning: Dates in Calendar are closer than they appear. 

 Because of these hard economic times, I have started selling furniture on the side. The trouble is, it is my own. 
 
 

Carlton’s CPE Prayer 
Now I lay me back to sleep. 

The speaker's dull; the subject's deep. 
If he should stop before I wake, 

Give me a nudge for goodness' sake. 

 


